# Contents

Documentation Guide ................................................................. vii  
  Introduction ............................................................................... vii
  Release and Migration Information ...................................... vii
  Tornado IDE and Tools ......................................................... viii
  VxWorks Operating System ..................................................... ix
  GNU Compiler and Tools ....................................................... xi
  Diab C/C++ Compiler and Tools ............................................ xii
  Online Documentation ........................................................... xii
  Documentation Conventions .................................................... xii

1 Overview .......................................................................................... 1
  1.1 Introduction ............................................................................... 1

2 Installing Tornado ................................................................................ 3
  2.1 Introduction ............................................................................... 3
  2.2 Before You Start ......................................................................... 4
    Licensing ................................................................................. 4
    Installing with Previous Versions of Tornado ....................... 5
    Windows Environment ......................................................... 5
    Obtaining the Installation Keys ............................................ 5
# Tornado 2.2 Getting Started Guide

## 2.3 Product Installation Procedure

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.3.1 Preliminary Installation Steps</td>
<td>6</td>
</tr>
<tr>
<td>2.3.2 Installing Tornado</td>
<td>8</td>
</tr>
<tr>
<td>2.3.3 Obtaining a Tornado License</td>
<td>13</td>
</tr>
<tr>
<td>Obtaining a Floating License</td>
<td>14</td>
</tr>
<tr>
<td>Obtaining a Node-Locked License</td>
<td>17</td>
</tr>
</tbody>
</table>

## 2.4 Uninstalling Tornado 2.2

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
</tr>
</tbody>
</table>

## 2.5 Administering License Management

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5.1 Installing and Configuring a License Server</td>
<td>23</td>
</tr>
<tr>
<td>Automatic License File Installation</td>
<td>25</td>
</tr>
<tr>
<td>Manual License File Installation</td>
<td>28</td>
</tr>
<tr>
<td>2.5.2 Managing Licenses</td>
<td>30</td>
</tr>
<tr>
<td>Summary of Floating License Management</td>
<td>30</td>
</tr>
<tr>
<td>Starting and Stopping the License Server</td>
<td>31</td>
</tr>
</tbody>
</table>

## 3 Tornado Tutorial

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Introduction</td>
<td>33</td>
</tr>
<tr>
<td>3.2 Start Tornado</td>
<td>34</td>
</tr>
<tr>
<td>3.3 Create a Project</td>
<td>36</td>
</tr>
<tr>
<td>3.4 Add the Sample Source File to the Project</td>
<td>40</td>
</tr>
<tr>
<td>3.5 Build the Project</td>
<td>42</td>
</tr>
<tr>
<td>3.6 Download the Project to the VxWorks Target Simulator</td>
<td>44</td>
</tr>
<tr>
<td>3.7 Run the Application from the Tornado Shell</td>
<td>47</td>
</tr>
<tr>
<td>3.8 Examine Target Memory Consumption</td>
<td>49</td>
</tr>
<tr>
<td>3.9 Examine Task Activity</td>
<td>50</td>
</tr>
<tr>
<td>3.10 Fix Task Priorities and Find the Next Bug</td>
<td>53</td>
</tr>
</tbody>
</table>
3.11 Fix the Last Bug and Take it for a Spin ......................................................... 55
3.12 What Next? ........................................................................................................ 58
Documentation Guide

Introduction

Documentation for Tornado falls into the following general categories:

- release and migration information
- Tornado IDE and tools
- VxWorks operating system
- GNU compiler and tools
- Diab compiler and tools

Each of these categories is described in this chapter. Online documentation and documentation conventions are also discussed.

Release and Migration Information

Tornado Release Notes

The Tornado Release Notes contain the latest list of supported hosts and targets, as well as information on compatibility with older releases, an outline of new features, and any caveats concerning the current release.

Tornado Migration Guide

The Tornado Migration Guide contains information designed to help VxWorks developers in moving from Tornado 2.2.x and VxWorks 5.4.x to Tornado 2.2 and VxWorks 5.5.
GNU Toolchain Release Notes

The GNU Toolchain Release Notes contain information about changes made to the GNU toolchain since the Tornado 2.0 release.

Diab Release Notes

The Diab C/C++ Release Notes contain information about changes made to the Diab compiler suite since the Diab 4.4 release.

Tornado Web Page

A Tornado 2.2/VxWorks 5.5 product information Web page is available at: http://www.windriver.com/corporate/support/prodbullet/T2.2/

Tornado IDE and Tools

Tornado Getting Started Guide

The Tornado Getting Started Guide (this manual) provides instructions on installing Tornado and other Tornado products, as well as tutorial introductions to both the Tornado tools and VxWorks.

Tornado User’s Guide

The Tornado User's Guide is the central document for the Tornado IDE. It includes:

- A global overview of Tornado and its capabilities.
- Instructions on how to configure your environment and set up communications with a target system.
- The Tornado development environment and its major interactive features—simulator, editor, project facility, target server management, shell, browser, and debugger.
- Command-line tools for project creation and debugging.
- COM and DCOM.
- Customizing Tornado.
- Tornado directories and files, the use of Tcl (Tool Command Language) in Tornado, and reference information for host tools.
- Wind River coding conventions.
Tornado API Programmer's Guide

The Tornado API Programmer's Guide is for developers who wish to extend the Tornado development environment. It contains descriptive information about:

- The run-time agent.
- Its host-system counterpart, the target server.
- The WDB protocol that supports the target agent and target server.
- The WTX C and Tcl protocols used by the Tornado tools to communicate with the target server.
- Client Component Architecture (CCA), which is the new architecture of the Tornado IDE.

Tornado API Reference

The Tornado API Reference is the reference companion to the Tornado API Programmer's Guide.

Tornado Reference

The Tornado Reference describes the host tools and utilities.

Tornado SETUP Developer's Guide

The Tornado SETUP Developer's Guide provides instructions for creating an installation image that can install products on top of Tornado.

WindView User's Guide

The WindView User's Guide describes the features and use of the WindView software logic analyzer, which is integrated with the Tornado IDE. The companion WindView User's Reference, describes WindView and networking events.

VxWorks Operating System

VxWorks Programmer's Guide

The VxWorks Programmer's Guide describes the VxWorks operating system and associated run-time facilities. This guide is the best starting point for learning about VxWorks from a problem-solving perspective because it is organized by the function of VxWorks components. It includes the following topics:

- The fundamentals of the VxWorks kernel and run-time environment.
The I/O system and the device drivers that underlie it.

Local file systems, including the DOS-compatible file system and the CD-ROM file system.

POSIX standard interfaces, which are real-time extensions to the VxWorks kernel facilities.

Target tools, which include the target-resident shell, loader, and symbol tables; as well as VxWorks show routines.

C++ development, with guidelines for creating VxWorks applications in C++ and configuring VxWorks to support them.

TrueFFs, a flash memory interface, which provides a block device interface to a wide variety of flash-memory devices.

Configuring and writing COM and DCOM applications for VxWorks.

VxMP, which provides shared-memory objects dedicated to high-speed synchronization and communication between tasks running on separate CPUs.

VxFusion, a lightweight, media-independent mechanism, based on VxWorks message queues, for developing distributed applications.

VxVMI, a virtual memory interface, which provides write protection and an architecture-dependent interface to the CPU’s MMU.

**VxWorks Architecture Supplements**

The VxWorks architecture supplements provide additional information specific to target architectures. ¹

**VxWorks Network Programmer’s Guide**

The Network Programmer’s Guide describes the networking facilities available with VxWorks. It includes the following topics:

- Configuring the network stack.
- Network configuration protocols.
- Dynamic routing protocols.
- Networking APIs.
- Booting over the network.

¹ For example, VxWorks for PowerPC Architecture Supplement.
Creating a new data link layer driver or network service.

NOTE: If you have installed Tornado with the default networking component, the networking guide is titled VxWorks Network Programmer’s Guide. If you have installed an optional networking product, the title is slightly different.

VxWorks API References

The VxWorks OS Libraries API Reference and the VxWorks Drivers API Reference include reference descriptions of all VxWorks libraries that apply to all targets. Each entry lists the routines found in a given library, including a one-line synopsis of each, along with a general description of their use.

VxWorks BSP Reference

The VxWorks BSP Reference consists of reference descriptions for BSP-specific libraries and routines for all installed BSPs. This section also contains entries for the serial, Ethernet, and SCSI drivers available with VxWorks Board Support Packages (BSPs).

VxWorks Errno Code List

The VxWorks Errno Code List provides a description of VxWorks errno codes, by number, by routine name, and alphabetically.

VxWorks BSP Developer’s Guide

The VxWorks BSP Developer’s Guide provides instructions on creating, documenting, and testing new BSPs, components, and projects.

GNU Compiler and Tools

The GNU ToolKit User’s Guide is a convenient collection of manuals for the GNU C and C++ compiler and its supporting tools: the C preprocessor, assembler, static linker, and binary utilities. Specific versions are provided for each architecture family. The GNU Make User’s Guide is the Free Software Foundation’s (FSF) manual for the make utility. The GDB User’s Guide is the FSF manual for the command-line interface to the GNU debugger GDB, which is the foundation for the Tornado graphical debugger, CrossWind.

NOTE: The FSF develops software under UNIX, and examples in their manuals reflect this. Nevertheless, the GNU tools operate reliably under Windows.
**Diab C/C++ Compiler and Tools**

The *Diab C/C++ Compiler Guide* describes the tools in the Diab C/C++ Optimizing Compiler Suites, including the compilers, assembler, linker, and utilities. The Diab suite is provided as the standard compiler for ColdFire, and is available for other architectures as an optional product.

**Online Documentation**

**Online Manuals**

Tornado includes a collection of all Tornado and VxWorks manuals in HTML format. You can open the online manuals from the Help>Manuals Contents menu in the Tornado IDE or at `installDir\docs\books.html`. An index and full-text search are available.

**Online Help**

Help buttons in every Tornado dialog box and the Help menu on the menu bar provide information on the Tornado component you are currently executing. In addition, from the shell, you can hot-key to the reference entry for the VxWorks routine you have entered.

**PDF Documents**

PDF versions of most books in the standard Tornado documentation set, as well as the Diab compiler guides, are provided in `installDir\SETUP\DOCS`. They are also available in the DOCS directory at the base of the Tornado core product CD.

**Documentation Conventions**

**Cross-References**

In the Tornado guides, cross-references to a reference entry for a specified tool or module refer to an entry in the online *VxWorks API Reference* (for target libraries or subroutines) or to the *Tornado API Reference* (for host tools).

Cross-references between books take the form Book Title: Chapter Name, and are not linked in the HTML version.
Pathnames

In general, all manuals refer to Tornado directories and files with pathnames starting at the installation directory `installDir`. Use the pathname chosen on your system for Tornado installation. Your working directory is referred to as `projDir`.

Screen Displays

The screen displays in this book are for illustrative purposes. They may not correspond exactly to the Tornado environment you see on your computer, because both Tornado and the Windows environment in which it runs can be customized. Tornado is also designed to permit easy integration with added tools.

Command-Line Examples

Tornado allows you to execute most functions either from within the IDE or from the command line. The command syntax is usually the same for Windows and UNIX command lines. For this reason these documents use the following default format for command lines:

```
% prjCreate
```

When a particular command syntax applies to UNIX only, this is stated. When a command syntax applies to Windows only, or when the Windows version differs from the UNIX version, the Windows format is:

```
c:\> winFooRun param
```

Typographical Conventions

Tornado manuals use the font conventions in the following table for special elements. C subroutine names always include parentheses, as in `printf()`. Combinations of keys that must be pressed simultaneously are shown with a + linking the keys. For example, `CTRL+F3` means to simultaneously press the key labeled `CTRL` and the key labeled `F3`.

<table>
<thead>
<tr>
<th>Term</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>files, pathnames</td>
<td><code>installDir\host</code></td>
</tr>
<tr>
<td>libraries, drivers</td>
<td><code>memLib.c</code></td>
</tr>
<tr>
<td>Command-prompt tools</td>
<td><code>dir</code></td>
</tr>
<tr>
<td>Tcl procedures</td>
<td><code>wtxMemRead</code></td>
</tr>
</tbody>
</table>
Table 0-1  **Typographical Conventions** *(Continued)*

<table>
<thead>
<tr>
<th>Term</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>C subroutines</td>
<td><code>semTake()</code></td>
</tr>
<tr>
<td>VxWorks boot commands</td>
<td><code>p</code></td>
</tr>
<tr>
<td>code display</td>
<td><code>main ()</code></td>
</tr>
<tr>
<td>keyboard input display</td>
<td><code>[vxKernel] -&gt; wtxregd -V</code></td>
</tr>
<tr>
<td>output display</td>
<td><code>value = 0</code></td>
</tr>
<tr>
<td>user-supplied values</td>
<td><code>name</code></td>
</tr>
<tr>
<td>components</td>
<td><code>INCLUDE_NFS</code></td>
</tr>
<tr>
<td>keywords</td>
<td><code>struct</code></td>
</tr>
<tr>
<td>named key on keyboard</td>
<td><code>RETURN</code></td>
</tr>
<tr>
<td>key combinations</td>
<td><code>ALT+SHIFT+F5</code></td>
</tr>
<tr>
<td>lower-case acronyms</td>
<td><code>fd</code></td>
</tr>
<tr>
<td>GUI titles and commands</td>
<td><code>Help</code></td>
</tr>
<tr>
<td>GUI menu path</td>
<td><code>Tools&gt;Target Server&gt;Configure</code></td>
</tr>
<tr>
<td>references to other manuals</td>
<td><code>VxWorks Programmer’s Guide: Basic OS</code></td>
</tr>
</tbody>
</table>
1 Overview

1.1 Introduction

Thank you for purchasing Tornado!

Tornado 2.2 provides a greater level of accessibility for users unfamiliar with Tornado, and increased productivity for experienced developers. Key features of this release are:

- the integrated version of the VxWorks target simulator (VxSim) introduced in Tornado 2.0
- the integrated version of the WindView logic analyzer for the target simulator introduced in Tornado 2.0
- an improved project facility
- a new debugger engine

The target simulator allows you to experience Tornado — as well as begin developing hardware-independent modules — without target hardware. The integrated version of WindView provides dynamic visualization of application behavior on the simulator. The new project facility provides automated graphical features for managing project files, configuring VxWorks, and building applications. The new debugger GUI is easier to use and provides more direct access to debug information.

This guide describes how to install Tornado and other compatible products. It also provides a simple tutorial that demonstrates the use of the project facility, the integrated versions of the target simulator and WindView, and the Tornado debugger. The tutorial is designed to provide new users with an accessible introduction to the key features of Tornado and their use in application
development. It is also intended to provide experienced Tornado users with an introduction to major innovations in the development environment.

NOTE: The integrated target simulator (VxSim-Lite) runs as a single instance per user, without networking support. Optional networking products are not available for this version. The full-scale version of the simulator, VxSim, is available as an optional product. It supports multiple-instance use, networking, and other optional products.

The integrated version of WindView is designed solely for use with the VxWorks target simulator. WindView is available as an optional product for all supported target architectures.

1.2 Terminology and Conventions

The following terms are used in this document:

- **host**
  A computer on which the Tornado IDE runs.

- **target**
  A processor board that runs VxWorks (Tornado’s real-time operating system) and applications developed with Tornado.

- **target server**
  A service that runs on the host and manages communications between host tools (such as the Tornado shell, debugger, and browser), and the target system itself. One target server is required for each target.

- **Tornado registry**
  A Tornado service that keeps track of, and provides access to, target servers. Only one registry is required on a network, but registries may be run on each Tornado host.

The following conventions are used in this document:

- As a convenience, the drive and root installation directory are identified as `installDir` in this document, but the location is determined at installation.

- A series of items to be selected from the GUI is denoted by `A>B>C`. The elements A, B, and C may be menu items, buttons, or tabs.
2

Installing Tornado

2.1 Introduction

This chapter provides step-by-step instructions for installing Tornado 2.2 and obtaining a license. It also tells a system administrator how to set up a floating license server and how to manage the server. This information is also available as online help for SETUP.

For a floating license installation, license server software must be installed and running on a host on your network before Tornado can run. A system administrator should install the license server software on a host designated for that purpose, using the same SETUP program that installs Tornado. System administrators installing the floating license server should refer to 2.5.1 Installing and Configuring a License Server, p.23 for step-by-step instructions.

If you are going to use a node-locked license, you will do the required configuration when you obtain the license as the final step of installation.

Installing Tornado 2.2 involves:

1. Setting up your Windows PC with the correct patches.
2. Locating the installation key. You will be installing from the Tornado core CD and from a BSP CD. Each has its own key.
3. Selecting a user account to use for installation.
4. Running the SETUP program. SETUP can be used to install either Tornado 2.2 or the floating license server. The program requires an installation key and some other information about your host.
Configuring Tornado to obtain a license, which may include some manual steps after the **SETUP** program completes. An optional authorization code may also be required for some installations.

**NOTE:** The installation instructions in this section also apply to any Tornado-compatible Wind River product that you have purchased separately. Optional products should be installed in the same directory tree as the version of Tornado for which they have been released.

---

## 2.2 Before You Start

If you are a system administrator installing license management on a server, go to 2.5.1 *Installing and Configuring a License Server*, p.23.

If you are installing Tornado 2.2 on your own machine, be sure you are installing on a supported host that meets minimum system requirements for both hardware and software, including patch levels. See the *Tornado Release Notes* for information about minimum system requirements and about using Tornado 2.2 in combination with other Wind River products.

**Licensing**

Tornado 2.2 and some optional components require a license. If you are installing on a host with access to the Internet, the setup and installation program configures the license for you, but before you start **SETUP** you should know:

- Whether the software you are installing requires a license. (Tornado 2.2 requires a license; some optional components do not.)
- If a license is required, what kind to use: *floating* or *node-locked*. (Refer to your purchase order.)
- If you will use a floating license, whether a floating license server is installed on a host in your network.
- If your system is running in 32-bit mode. (Tornado 2.2 runs only in 32-bit mode.)
If you do not know the answers to these questions, check with your system administrator.

**Installing with Previous Versions of Tornado**

If you plan to install Tornado 2.2 on a host that has another version of Tornado installed, see the *Tornado Release Notes* for information about correctly installing alongside your current version. You can never install a new Tornado in an existing Tornado tree.

> **NOTE:** If you plan to install Tornado 2.2 on a system that has the Beta version already installed, you must first *uninstall* the Beta version.

**Windows Environment**

**TCP/IP Networking**

Before you install Tornado 2.2 on a Windows host, make sure that TCP/IP networking is installed. Tornado 2.2 can operate over a raw serial connection between the host and target systems, and can operate on standalone systems that have no network connection with other hosts. However, the Tornado 2.2 tools use the TCP/IP protocol to communicate with one another, and you must therefore have TCP/IP on your host even if it is not on a networked system. The Windows TCP/IP package is generally installed with the operating system. (See `Start>Settings>Control Panel>Network>Protocols`.) Consult your Windows documentation for information on installing and configuring TCP/IP.

**Long File Names**

Before you install Tornado 2.2 on a Windows host, long file names must be enabled (the default setting).

**Obtaining the Installation Keys**

If you have purchased Tornado, your installation key is printed on the Installation Keys sheet in the *Getting Started* portfolio that includes the Tornado 2.2 CD-ROM and this guide.
If you cannot find the installation keys, contact Wind River by e-mail at license@windriver.com. Please include your sales order number if you have purchased Tornado.

You can also call 1-800-USA-4-WRS (1-800-872–4977) if you are in North America and ask for Key Administration. In other locations, contact the nearest Wind River office.

### 2.3 Product Installation Procedure

#### 2.3.1 Preliminary Installation Steps

On Windows systems you must use an account with administrator privileges when installing Tornado 2.2. The installation program makes some changes to the Windows system configuration that require administrator privileges.

**Step 1:** Start the SETUP Program

Insert one of the Tornado 2.2 CD-ROMs in the drive. Install the Core CD first, followed by the BSP/driver CD. The SETUP program starts automatically the first time you run it. On subsequent occasions, you can start SETUP again on Windows by displaying the contents of the CD-ROM drive (using Windows Explorer or a comparable file manager) and double-clicking on SETUP.EXE, which is at the root of the CD-ROM file system.

The SETUP program has online help that provides detailed information about the installation and license configuration process. Click on the Help button to access help from any dialog where the button is enabled (starting with the User Registration page).

Each SETUP dialog box also has a Cancel button, which you can use to exit from the installation program. To continue to the next box, click the Next button. To return to the previous box to review or change information you have entered, click the Back button (which is grayed-out if it cannot be used).

When SETUP starts, the Welcome dialog box appears. To continue, click Next.
Step 2: Review the Readme Information

The README.TXT window appears next. When you have finished reviewing the information contained in the window, click Next.

Step 3: Review the License Agreement

Read the license agreement. If you agree with its conditions, click I Accept and Next to proceed with installation.

Step 4: Enter User Information and Installation Key

In the User Registration dialog, enter the primary user name, your company name, and the installation key.

> NOTE: Enter the key exactly as it appears on the Installation Keys sheet. The key is case sensitive, and all characters must be entered, including non-alphabetic characters.

If you have already installed other products from the same CD-ROM, you can select the installation key from the drop-down list. Otherwise, copy it from the Installation Keys sheet.

> NOTE: The two CD-ROMs associated with Tornado 2.2 require different keys. Both are on the Installation Keys sheet.

To continue, click Next.

Step 5: Choose the Type of Installation

In the Installation Options dialog choose one of the following:

- Full Installation. Choose this option to install a complete copy of Tornado 2.2 for an end user on the local host. Click Next to continue. (This is the option most users will use.)

- Shortcuts Installation. Windows users can choose this option to configure the local host to use a copy of Tornado 2.2 that is installed on another host. Choosing this option does not install the program files on the local host. Click Next to continue, then proceed with Step 7 and Step 9.

- License Management Server Installation. This option installs and configures a floating license server on the local host. The floating license server manages a pool of licenses for use by installations on other hosts in a network. System administrators installing a floating license server should select this option and
click Next to continue. See 2.5.1 Installing and Configuring a License Server, p.23, then follow the steps listed there.

NOTE: A license server must be installed and available on a network before Tornado 2.2 can be configured to use floating licenses. Before you install Tornado and attempt to configure it to use a floating license, you should ensure a license server has been installed.

To continue, click Next.

**Step 6: Enter the Project Information**

The license number and number of seats is shown on the Tornado Installation Keys form that shipped with your product.

**2.3.2 Installing Tornado**

**Step 7: Specify the Installation Directory**

Tornado 2.2 and its related products are designed to be installed in a single directory tree. Specify the drive and root directory for that tree in the Select Directory dialog box (for example, c:\Tornado2.2).

**WARNING:** Do not install Tornado 2.2 in a directory whose path includes embedded spaces (for example, c:\Program Files\Tornado2.2). Installing in such a path causes make and other essential utilities to malfunction.

**WARNING:** Do not install Tornado 2.2 in the same directory as any prior installation of Tornado, or in the same directory as versions of Tornado for other target operating systems (such as Tornado for I2O). Unpredictable behavior may result. For more information about installing Tornado 2.2 alongside existing installations of Tornado, refer to the Tornado Release Notes.

You can use the Browse button to display a file browser for locating and choosing the installation directory. If the directory you specify does not exist, you will be prompted to create it.

If you are installing only shortcuts to a remote server, be sure that the destination directory you specify is the one where a full installation was performed. Continue with Step 9.

To continue, click Next.
Step 8: Review the Product List for Installation

All of the products you ordered are marked as selected in the Select Products dialog box by a check in the box to the left of the product name. Each item in the list represents a single product. To include or omit a product, click the checkbox next to the product name.

The line at the bottom indicates how many components comprise the selected product. If you highlight a product by clicking on it, the line at the bottom displays how many components within that product are selected. For example, in the Select Products dialog box, if Tornado Tools: x86win32 x ppc is highlighted, the dialog shows 4 out of 6 components are selected. To see a list of the individual components for a product, click the Details button. See Selecting Parts, p. 10 for more information.

A Tornado 2.2 installation requires the following minimum components:

- Tornado tools for the host system
- target processor and family
- driver objects and headers for the selected target (These are on your second, BSP/driver CD-ROM.)

By default, these components are chosen for installation. This ensures that the necessary base product is installed, and that other products will install successfully later. This is especially important when:

- Your installation key covers more than one product, or multiple run-time components such as TrueFFS or individual BSPs, and you choose to install them separately.
You have more than one installation key covering different products.
You have separate CD-ROMs containing add-on products.

Click Next to continue.

If there is not enough space for the selected products, SETUP warns you and gives you the option of going back to specify a directory on a larger disk or partition. You can also go back and omit some products. Click Go Back to return to the Select Directory dialog box, or No to continue. If you click No and continue, you will be prompted later to free up disk space.

NOTE: Some components rely on other components. If you select one component without also selecting others it relies on, the SETUP program warns you and may require you to go back and change your selections before continuing to the next step.

Click Next to continue.

Selecting Parts

If a product has more than one part, clicking Details opens the Select Parts dialog, which displays all the parts in a list. You can modify the default selection of parts using this list. Check or uncheck the boxes to the left of the names.

This dialog also displays the approximate amount of disk space required for the selected parts.

Click OK to accept any changes you make to the list of parts, or Cancel to ignore any changes.
Step 9: **Select a Name for the Start Menu Program Folder**

Select a Windows Start menu program-folder name for Tornado with the Select Folder dialog box. By default, a Tornado entry is created under Programs in the Start menu. To continue, click Next.

Step 10: **Set Up the Tornado Registry**

The Tornado registry is a service that keeps track of all available target servers. A target server is a service that runs on the host and manages communications between host tools, such as the shell, debugger, and browser, and the target system itself. A registry must be running before target servers can be started and before tools can communicate with a target.

In the Tornado Registry dialog box choose one of the following options:

- **Install Tornado Registry as an NT Service**
  Select this option to have the registry started on the local host at boot time. Click Next.

- **Install Tornado Registry in the Startup Group**
  Select this option to have the registry started automatically on the local host when the current user logs on. If you choose this option, you need to reboot your PC or run Tornado 2.2 before automatic startup of the registry takes effect. Click Next.

- **Install Tornado Registry manually**
  Select this option if you want to start the registry manually using the Windows Start menu before running Tornado 2.2. The registry automatically starts if none is running. Click Next.

**NOTE:** For advanced users: If you want this installation to use a Tornado 2.2 registry located on another machine, select Install Tornado Registry manually. Then, when you start Tornado, go to Tools>Options. Select the Target Manager pane and enter the machine name in the WIND_REGISTRY field.

**Configure to Use a Remote Tornado Registry**

Select this option if the Tornado registry will be installed on another machine and you want to configure your machine to communicate with it. Click Next.
Step 11: Backward Compatibility

If you plan to use Tornado 1.0.1 and Tornado 2.2 tools in the same development environment, select yes in the Backward Compatibility dialog box. See the Tornado Release Notes for information about mixed-release development environments and portmapper usage.

NOTE: If you chose to install the Tornado registry as a service in Step 10, you will be unable to use Tornado 1.0.1 tools with Tornado 2.2. You can use the Back button to return to the Tornado Registry dialog box, and change your selection.

Step 12: Register File Types

SETUP can configure Windows to associate certain file extensions with Tornado 2.2 applications. This function of SETUP is only available if the Windows account you are using to install Tornado has system administrator privileges. In the Configure Default Application dialog, choose the file extensions you want to associate with Tornado as the default application. Click Next to continue.

Step 13: SETUP Installs Files

SETUP begins to copy files from the CD-ROM. As installation progresses, the program displays information about the product as well as the names of the files being installed. The process may take several minutes.
When SETUP has finished copying files, a dialog confirms installation of the products you selected for Tornado 2.2. You still need to install one or more BSPs from the second installation CD-ROM you received, but first, complete license manager installation. Click OK to close the dialog.

Next, SETUP configures Tornado 2.2 to reserve a license.

### 2.3.3 Obtaining a Tornado License

If the product you have installed (such as Tornado 2.2) requires a license, the SETUP program presents additional dialogs to select the type of license and to obtain one for use.

**Step 14: Choosing a Licensing Method**

Tornado 2.2 obtains a license using one of two methods. In the License Management Configuration dialog, you choose the method for your installation to use. If you are unsure of which one to use, ask your system administrator or refer to your purchase order.
Configure a Floating License
Choose this method to reserve a license from a pool of shared licenses every time you run Tornado 2.2. When you exit Tornado 2.2, the license is released for other installations to use.

NOTE: A license server must be installed and available on your network before Tornado 2.2 can be configured to use floating licenses. Before you install Tornado 2.2 and attempt to configure it to use a floating license, you should first ensure that a license server has been installed. See 2.5.1 Installing and Configuring a License Server, p. 23 for more information.

Configure a Node-Locked License
Choose this method to obtain a license and reserve it for use only on this computer. Laptop computers that are often disconnected from the local network (and therefore cannot connect to a floating license server) should use this method. The license is contained in a file stored in the local installation, and the installation uses it exclusively thereafter.

Recapture license previously configured for this machine
If a node-locked license for Tornado 2.2 was previously reserved for the host, and you want to configure the present installation to reuse that license, then check the box.

Choose an option and click Next to continue.

To proceed with the floating license option for typical end users, see Obtaining a Floating License, p. 14.

To proceed with the node-locked licensing option, see Obtaining a Node-Locked License, p. 17.

Obtaining a Floating License

This section describes the steps to configure Tornado 2.2 to obtain a floating license from a license server on your network. For instructions on obtaining a node-locked license, see Obtaining a Node-Locked License, p. 17.

NOTE: A license server must be installed and available on your network before Tornado 2.2 can be configured to use floating licenses. Before you install Tornado 2.2 and attempt to configure it to use a floating license, you should first ensure that a license server has been installed. See 2.5.1 Installing and Configuring a License Server, p. 23 for more information.
1. Query the License Database

SETUP can automatically retrieve information from Wind River about the licenses you have purchased. In the Database Query Permission dialog, you give permission for SETUP to contact Wind River for this purpose. Your computer must have an active connection to the Internet to complete this step.

Yes, contact Wind River web site
Select this option to retrieve the information automatically, then click Next. SETUP transfers only the information necessary to configure a license for Tornado 2.2, and no other data, from your computer. See 2.Select License Server(s), p.15 to continue.

No, do not contact the Wind River web site
If you select this option, the installation of Tornado 2.2 is complete but it has not obtained a license. If you do not obtain your license now, there are two ways to initiate license configuration later:

- Start SETUP with the -L option.
- Start Tornado. When you run any Tornado 2.2 tool that is under license management, SETUP starts and steps you through obtaining a license.

Click Next to continue.

NOTE: In the Finish dialog that appears when you choose not to contact the Wind River web site, SETUP displays information about manually configuring Tornado 2.2 to use a floating license. Make a note of the instructions, then click Exit to leave SETUP.

2. Select License Server(s)

The User License Management Configuration dialog displays the license servers on your network, from which Tornado 2.2 can request a floating license.

Click one or more server names listed in Available Server(s). To add them to the list of Selected Server(s) click on the button. Click on the button to remove them. Use the Up and Down buttons to prioritize the selected servers. Tornado 2.2 sends its request for a license to the server at the top of the list first.

To see more information about an individual server and the licenses available on it, click to highlight the server; then click the Details button while the server name is highlighted.
No Servers Available

If no entries appear under Available Server(s), this means SETUP cannot locate any license servers. Possible reasons for this and their solutions are:

- No license server is installed on an accessible host in your network; contact your system administrator to have one installed.
- The license server is installed on an accessible host but is not active; contact your system administrator to activate it.
- The host is not connected to the network; troubleshoot the connection. If the machine is normally not connected to the network (for example, a laptop), consider assigning a node-locked license. See Obtaining a Node-Locked License, p.17.

Click Next to continue.

3. Confirm License Servers

In the License Management Registration dialog you can review your choice of license servers. Click Next to accept the choice, or Back to modify it. When you click Next, SETUP displays the Finish dialog.

SETUP updates the registry with the license information. There are no further steps to complete. Congratulations! You have configured Tornado 2.2 to obtain a floating license, and it is now ready to run.
Obtaining a Node-Locked License

A node-locked license is a license reserved exclusively for a single Tornado 2.2 installation. The license is contained in a file stored locally during setup and Tornado 2.2 uses it exclusively thereafter. This section describes the steps to follow to reserve a node-locked license and to obtain the license file.

Choose a Method for Requesting the License File

In the License Management Installation Options dialog, select a method for SETUP to contact Wind River and request the license file.

Automatic License Installation

Recommended because it is the quickest and easiest method, and when you exit the SETUP program the license file is installed. This method requires an active Internet connection. See Automatic License Installation, p.18, if you choose this method.

Manual License Installation

Choose one of the manual options (e-mail, phone, or fax) if the host is not connected to the Internet, or if you are located behind a firewall or a proxy server that prevents automatic installation from completing. When you request a license file using one of these methods, the file is sent to you through e-mail and you must install it manually. Click Next and see 3.Select Node-Locked Licenses to Configure or Reload, p.20 to continue.

If the host has no Internet access and cannot send e-mail, a final option for obtaining a license file is to visit the Wind River Web site using another computer.
that does have network access. Visit http://www.windriver.com/ali and follow the instructions there. Once you have the file, copy it to a diskette and transfer it to the install host, as described in 3. Install the WRSLicense.lic License File Manually, p. 22.

Automatic License Installation

This section describes the steps to follow when requesting a node-locked license using the Automatic License Installation option.

1. Query the License Database

In order to obtain the license file, SETUP automatically retrieves information from Wind River about the licenses you have purchased. In the Database Query Permission dialog, you give permission for SETUP to contact Wind River for this purpose. Your computer must have an active connection to the Internet to complete this step.

Use Disk Serial Number for host ID

Select this option if you are installing a Tornado product on a laptop with multiple NIC cards. Click the Details button for more information.

Yes, contact Wind River web site

Select this option to retrieve the information automatically. Before you click Next, review the information that will be transferred. SETUP transfers only the information necessary to configure a license, and no other data from your computer.

You may wish to use your disk serial number as your host ID instead of using your MAC address (the default). This option is recommended if you have a
laptop with multiple NIC cards and you switch between the cards. For more information, see http://www.windriver.com/corporate/support/license.html. Click Next to continue.

No, do not contact the Wind River Web Site
If you select this option, SETUP displays instructions for manually installing a license file (see 3. Install the WRSLicense.lic File Manually, p. 29). If you wish, you can return to the previous dialog, where you can choose one of the manual methods of requesting the license file instead. See Choose a Method for Requesting the License File, p. 17.

2. Provide Contact Information/User Authorization
Choosing Yes from the dialog above opens the Contact Information/User Authorization dialog. Enter contact information for the person who coordinates license configuration and management at your site. SETUP includes this information in the request for a license file.

Authorization Code
Your purchase agreement for Tornado 2.2 may have included a request for an authorization code, used to restrict access to licenses. If so, this dialog is labeled User Authorization and it includes a field for the code. You can find the code on the Installation Keys sheet. You must enter the code before you can request or reserve any licenses.
Click Next to continue.
3. Select Node-Locked Licenses to Configure or Reload

If you are requesting new licenses, the Node Locked License Configuration dialog displays the number of licenses still available out of the total purchased. Select the licenses you want to reserve by checking the boxes next to the product name. Each node-locked license you reserve in this dialog reduces the number of licenses available for other Tornado 2.2 installations.

If you are reloading a license that was previously assigned to this host, the Reload Existing License dialog appears instead. This dialog displays information about the license(s) to be restored. You can review this information but you cannot alter it.

When you have selected new licenses to reserve, or reviewed the licenses to be restored, click Next to continue and see 4. Review License Management Summary, p. 22.

Manual License Installation

This section describes the steps to follow when requesting a node-locked license using one of the manual methods.

1. Select Products to License

The Email License Configuration dialog or the Phone/Fax License Configuration dialog appears, depending on the manual method you have chosen. The following image shows the Phone/Fax dialog, but the contents of the two dialogs are the same for both methods. The dialog displays the products you have installed, and for which you can request a node-locked license. Select the
licenses you want to reserve by checking the appropriate boxes next to the product names.

Click Next to continue.

2. Request the License

Next, you must provide information gathered by SETUP to Wind River. After Wind River has the information, you will receive the license file through e-mail.

- Request the License File by E-mail

To use this method, the host must have network access to a mail server.

(a) SETUP inserts all the necessary information into an e-mail message that you can preview in the Email License dialog. When you have viewed the message, click Next to continue.

(b) In the Mail Confirmation dialog, enter the e-mail address where you want the license file to be sent. Select a mail protocol and enter the name of the mail server to use.

(c) Click Send in the Mail Confirmation dialog. The request is sent from the current host to license@windriver.com.

(d) See 3.Install the WRSlicense.lic License File Manually, p.22.

- Request the License File by Phone

(a) SETUP copies all the necessary information into a file that you can preview in the Contact Wind River dialog and print for your reference.
(b) Call Wind River at the number listed on the dialog and give the information to the license representative.
(c) Click on Finish to exit the SETUP program.
(d) See 3.Install the WRSLicense.lic License File Manually, p. 22.

3. Install the WRSLicense.lic License File Manually

When you receive the license file WRSLicense.lic, do not alter its contents or change the file name. Copy it to the directory installDir\wind\license, where installDir is the directory in which Tornado 2.2 is installed.

4. Review License Management Summary

The Summary dialog shows the license(s) or server(s) you have configured for this installation. If the information is correct, click Next to accept the results. To go back and change the configuration, click on Back or Cancel.

One final step is necessary for certain installations. You need to set some host environment variables on UNIX hosts, and on Windows hosts if you have configured node-locked licensing and you received the license file WRSLicense.lic by e-mail.

In these cases, see page 4.Complete Installation, p. 29 to complete this step. Otherwise, you are done installing Tornado 2.2 and configuring a license for it.

For an introductory tutorial on Tornado 2.2 usage, see 3. Tornado Tutorial.

2.4 Uninstalling Tornado 2.2

⚠️ WARNING: Before uninstalling Tornado 2.2, make copies of any Tornado files you have modified. Uninstalling Tornado removes all files that were part of the original distribution list.

To remove Tornado 2.2 from a Windows host system, you can use standard Windows Control Panel facilities or the Tornado Uninstall program. Before you remove Tornado 2.2, you must shut down all Tornado 2.2 tools and components, including those you may have arranged to start automatically, such as the Tornado 2.2 target server and registry.
To use the Windows Control Panel facilities to uninstall Tornado 2.2:
1. Select Start>Settings>Control Panel.
2. Double-click Add/Remove Programs.
3. Select Tornado 2.2 from the list.
4. Click the Add/Remove button.

To use the Uninstall program:
1. Select the Tornado program folder from the Start menu under the Programs folder. (This is the default folder name and location; another may have been selected at installation.)
2. Select Tornado 2.2 Uninstall.

2.5 Administering License Management

2.5.1 Installing and Configuring a License Server

This section describes the steps for installing and configuring a license server using SETUP. If your site will use floating licenses, at least one license server must be in place before Tornado 2.2 floating seats and licensed optional products can be used. The license server manages a pool of floating licenses for use by Tornado 2.2 installations on other hosts on a shared network.

This section is relevant for system administrators who want to install the network license server, and not for typical end users of Tornado 2.2. It is not part of standard product installation, but must be completed before any licensed products can be used with floating licenses.

NOTE: A license server must be installed and available on a network before Tornado 2.2 can be configured to use floating licenses. Before users install Tornado 2.2 and attempt to configure it to use a floating license, ensure that a license server is installed.
Step 1: Run SETUP

The initial steps required for installing a license server are the same as 2.3 Product Installation Procedure, p.6. Follow Step 1 through Step 6 first. When the Installation Options dialog appears, select License Management Service Installation and click Next.

NOTE: To install only license management daemons and utilities files, you can invoke SETUP with the -F or /F option. If you use -F or /F, SETUP takes you directly to Step 2.

Step 2: Choose a Directory for License Management Utilities

SETUP asks you to confirm that this is the correct host on which to install the license manager software before proceeding. If it is not, exit the program now. Choose a local directory for the license management files. Click Next to continue.

If you wish to reinstall your existing license file without adding licenses or making any other changes, check the box.

Step 3: Select Installation Method

The license manager requires a license file installed locally on the server machine. The file is generated upon request by Wind River. In the License Management Installation Options dialog, select a method for contacting Wind River to request the license file.
Installing Tornado

Automatic License Installation

Recommended because it is the quickest and easiest method if you have an active connection to the Internet. When you exit the SETUP program, the license file is installed. Click Next and see Automatic License File Installation, p. 25, if you choose this method.

Email option or the Phone or Fax option

Choose one of these manual options if the host is not connected to the Internet, or if you are located behind a firewall. When you request a license file using one of these methods, the file is sent to you through e-mail and you must install it manually. Click Next and see Manual License File Installation, p. 28 to continue.

If the host has no network access and cannot send e-mail, you can visit the Wind River Web site using another computer that does have network access. Visit http://www.windriver.com/ali and follow the instructions there. Once you have the file, copy it to a diskette and transfer it to the install host, as described in 3. Install the WRSLicense.lic File Manually, p. 29.

Automatic License File Installation

This section describes the steps to follow when requesting a license file using the Automatic License Installation option.

1. Query the License Database

SETUP can automatically retrieve information from Wind River about the licenses you have purchased. If your computer has an active connection to the Internet, you can give permission for SETUP to contact Wind River for this purpose.

Yes, contact Wind River web site

Select this option to retrieve the information automatically, then click Next. SETUP transfers only the information necessary to configure a license, and no other data, from your computer. Click Next to continue.

No, do not contact the Wind River Web Site

If you select this option, SETUP returns to the previous dialog, where you can choose one of the manual methods of requesting the license file instead.

2. Provide Contact Information/User Authorization

In the Contact Information/User Authorization dialog, enter contact information for the person who coordinates license configuration and management at your site. SETUP includes this information in the request for a license file.
Authorization Code
Your purchase agreement may have included a request for an Authorization Code: a number used to restrict access to licenses. If so, this dialog is labeled User Authorization and it includes a field for the code. You can find the code in the Installation Keys sheet. You must enter the code before you can request or reserve any licenses. Click Next to continue.

3. Choose a License Server Port
The license server receives requests for floating licenses on a dedicated port. Use the License Server Port dialog to select the port the server will use. You can accept the default of 27000 or choose an unused one numbered 1024 or higher. Click Next to continue.

4. Specify Floating Licenses to Manage
The Floating License Configuration dialog lists the products for which you have purchased licenses, the number of licenses, if any, that the current host is managing, and how many licenses are available to claim. Enter the number of licenses for each product that you want the server to manage in its pool of licenses.

If you are increasing the number of licenses for the server, then the numbers you enter will reserve additional licenses.

In either case, the number that remains for other servers to claim is reduced accordingly.
WARNING: If you install more floating seats than appear on your purchase order, Wind River will contact you to reconcile the difference. Please review your purchase order before installing to be sure that you install only as many licenses as you have purchased or wish to purchase.

When you have made your selection, click Next to continue. The Summary: Floating License dialog shows the total number of licenses you have configured for the license server to manage. To accept the configuration, click OK. To go back and change the configuration, click Cancel.

5. License Manager Startup Options

The License Management Startup Options dialog offers the following options.

![License Management Startup Options](image)

Install License Manager locally as an NT Service
Select this option to have the license manager start on the local host at boot time.

Install License Manager in the Startup Group
Select this option to have the license manager start automatically on the local host when the current user logs on.

Install License Manager to be run Manually
Select this option if you want to start the license manager manually using the Windows Start menu.

Click Next to continue.
**Manual License File Installation**

This section describes the steps to follow when requesting the license file using one of the manual methods.

1. **Select Products to License**
   
The Email License Configuration dialog or the Phone/Fax License Configuration dialog appears, depending on the manual method you have chosen. The following image shows the e-mail dialog, but the contents of the dialogs are the same for both methods. The dialog displays the products for which you can request a license file. Indicate the number of licenses you want to reserve in the fields next to the product names.

![License Configuration Dialog](image)

2. **Manually Send the Request for a License File**
   
   To complete your request for the license file manually, you must provide the following information in your request. **SETUP** collects the information in an appropriate format for you to send to Wind River:
   
   (a) host ID of the machine to be the license server
   (b) host Name—the name of the license server host
   (c) your customer license number
   (d) number of licenses to be served for each licensed Wind River product (for example, five licenses for Tornado 2.2 and three for WindView).
   (e) contact information (name, address, phone, e-mail address).
NOTE: The host ID is a number that the license manager software uses to uniquely identify the host machine. SETUP determines this number for you automatically, but you can also find it manually by issuing the command `lmutil lmhostid` from a host command line in the `installDir\SETUP\X86\WIN32\` directory.

- **Request the License File by E-mail**
  
  (a) All the necessary information is put in an e-mail message. You can preview the message in the Email License dialog. Click Next to continue.
  
  (b) In the Mail Confirmation dialog enter the e-mail address where you want the license file to be sent. Select a mail protocol and the ID of the mail server used by the host.
  
  (c) Click Send. The request is sent from the current host to `license@windriver.com`, and an automated system receives it.

- **Request the License File by Phone**
  
  (a) All the necessary information is copied to a file which you can preview in the Contact Wind River dialog and print for your reference.
  
  (b) When you call Wind River at the number listed on the dialog, have the information available to provide to the representative.
  
  (c) Click on Finish to exit the SETUP program.

3. **Install the WRSLicense.lic File Manually**

   When you receive the license file `WRSLicense.lic`, do not alter its contents in any way or change the file name. Copy it to the directory `installLic\.wind\license`. The `installLic` directory is where license management software is installed.

   **CAUTION:** In most cases you should not alter the file contents or its filename. If you do wish to rename the license file, relocate the file to a path other than `installLic\.wind\license`, or combine the contents of the license file with other license files, please consult the user documentation from Globetrotter at [http://www.globetrotter.com](http://www.globetrotter.com).

4. **Complete Installation**

   After running the SETUP installation program, you may need to set environment variables. You must set host environment variables if you installed Tornado 2.2 or the license server, but you received the license file `WRSLicense.lic` by e-mail and installed the file manually.
Windows 2000 Pro and XP Pro:
(a) Go to Control Panel>System.
(b) Click on the Advanced tab.
(c) Click on the Environment Variables button.
(d) Click on the New button under the System Variables section.
(e) In the Variable Name edit box, enter LM_LICENSE_FILE.
(f) In the Variable Value edit box, enter the full path location of the license file.

Windows NT 4.0:
(a) Log on to Windows using the same account that was used to install the license manager.
(b) Go to Start>Settings>Control Panel>System.
(c) Choose the Environment tab.
(d) In the Variable edit box, enter LM_LICENSE_FILE.
(e) In the Value edit box, set the value of the variable to the full path location of the license file.
(f) Click OK.

2.5.2 Managing Licenses

This section is intended for license administrators to get started using the license management software for Tornado 2.2.

Tornado 2.2 uses the FLEXlm license management system by Globetrotter Software. For detailed information about FLEXlm, including downloadable user documentation, visit http://www.globetrotter.com.

Summary of Floating License Management

The following is a summary of floating license management for Tornado 2.2:

* The license manager software runs on one or more hosts designated as floating license servers on your shared network.
* FLEXlm requires a license file installed on each server machine. This file is obtained from Wind River during installation of the license server.
* When a Tornado 2.2 installation on your shared network needs a floating license to run, it requests the license from a floating license server.
* The floating license server must be started in order to serve licenses to Tornado 2.2 installations.
Starting and Stopping the License Server

To make the floating licenses available to Tornado 2.2 installations on the shared network, the license manager must be started on the server.

On Windows hosts, you can use the license manager utility to start the license manager:

1. In the Windows Explorer open the folder where you installed the license manager utilities.
2. Double-click `lmtools.exe` and go to the Start/Stop/Reread tab.

You can also start the license server from a command line. Follow the steps below, substituting for `installLic` the directory where the license manager was installed.

1. Change directory to the location where the license utilities are installed:
   ```
   c:\> cd installLic\host\x86-win32\bin
   ```
2. Issue the startup command:
   ```
   c:\> lmgrd -z -c installLic\win\license\WRSLicense.lic -l installLic\win\license\lmgrd.log [-x lmdown]
   ```

To stop a license server that has been started manually using the above steps, do the following:

1. Open the Windows Task Manager (CTRL+SHIFT+ESC).
2. Choose the Processes tab.
3. Select the process named `lmgrd`.
4. Click the End Process button.
3

Tornado Tutorial

3.1 Introduction

This tutorial is designed to introduce you to key features of Tornado using the integrated VxWorks target simulator. It does not require any target hardware or special configuration of your host system. It is not a programming tutorial; the sample program was written to exercise Tornado in illustrative ways.

While simply reading the tutorial may be edifying, we encourage you to perform the steps described in this chapter so that you can experience Tornado first hand. In the course of the tutorial, you will:

- Use the project facility to create a workspace and project for a sample program.
- Build the program from the project facility GUI.
- Download the program to the VxWorks target simulator on your host system.
- Use the Tornado shell to run the sample program.
- Use the browser to observe memory usage on the target simulator.
- Use the WindView software logic analyzer to graphically display the execution flow of the sample program and to identify a problem with task prioritization.
- Use the debugger to identify a runtime application error.

Naturally, you will have several opportunities to modify the program to correct its runtime behavior, rebuild it, download it, and run it again.
The tutorial assumes minimal knowledge of multi-threaded programming in C, and basic Windows usage.

You might approach the tutorial with the following scenario in mind:

A colleague has abruptly announced that he is going on vacation, and the VP of Engineering has handed you the delinquent’s portion of The Project. You are alarmed. His code is typically cryptic, poorly documented, and full of run-time mischief. The thought of reading his source gives you a headache. And the target hardware seems to have gone on vacation with him. You decide to use Tornado’s target simulator and analytical tools to see how the code behaves...

NOTE: This tutorial is intended for use with the integrated VxWorks target simulator. The results may differ if used otherwise (with target hardware, for example).

3.2 Start Tornado

To start Tornado, select Start>Programs>Tornado2.2>Tornado (with a default installation), or select the Tornado desktop shortcut (if you have created one).

If Tornado is unable to connect to a Tornado registry, you will be prompted to start one. See Step 10: Set Up the Tornado Registry, p. 11 for information about registry configuration options at installation. You can start a registry manually by selecting the Tornado Registry option from the Tornado program group menu.
The main Tornado window appears with the Create Project dialog box open by default:

![Tornado window with Create Project dialog]

You can use the toolbars as floating palettes or dock them on the sides, top, or bottom of the main Tornado window.
3.3 Create a Project

If the Create Project in New/Existing Workspace dialog box is not displayed, click File>New Project.

Then select the option for a downloadable application:

Click OK to continue.

The Tornado application wizard appears. This wizard guides you through the steps of creating a new project. In the first step, the wizard prompts you for:

- A name for the project.
- The full path and name of the directory you want to use for the project files.
- An optional description of the project.
- The name and location of the workspace file, which contains information about the workspace, including which projects belong to it.

A project consists of the source code files, build settings, and binaries that are used to create an application.

A workspace is simply a grouping of one or more projects, which provides a useful means of working with related material, sharing code between projects, and associating related applications. Once a project and workspace have been created, a workspace window displays information about the projects that it contains.

You can accept the wizard’s defaults for the project and workspace, but it is preferable to set them up outside of the Tornado installation tree. (If you do so, you won’t have to untangle your work from the Tornado tree when you upgrade Tornado.)
In the wizard dialog (displayed below):

- The project name is gizmo.
- The project directory is c:\projects\gizmo.
- The project description is lightning gizmo.
- The path and file name for the workspace are c:\projects\lightning.wsp.

Click Next to continue.

In the second wizard dialog, you identify the toolchain with which the downloadable application will be built.

A toolchain is a set of cross-development tools used to build applications for a specific target processor (preprocessor, compiler, assembler, and linker).

The default toolchain names for target simulators take the form SIMhostOsgnu (for example, SIMNTgnu).

NOTE: The directory path for the workspace must exist—or at least match the path (or an initial segment thereof) defined in the project Location field—for the wizard to complete project creation.
Select a toolchain and the option for the target simulator from the drop-down list, as illustrated below:

Click Next to continue.

The final wizard dialog confirms your selections:
Click Finish to continue.

The **Workspace** window appears. The workspace window title includes the name of the workspace, and the window itself includes a folder for the project:

![Workspace window](image)

**NOTE:** Context menus provide access to all commands that can be used with the objects displayed in, and the pages that make up, the Workspace window. Use the right mouse button to display an object’s context menu.
3.4 Add the Sample Source File to the Project

The sample program for this tutorial is cobble.c. It is a simple multi-tasking application that simulates a data collection system in which data is retrieved from an external source (for example, a device that generates interrupts as data comes in). The four cobble tasks are:

- **tCosmos**, which simulates an interrupt service routine (ISR) and generates new data.
- **tSchlep**, which collects the data.
- **tCrunch**, which performs calculations on the data to obtain a result value.
- **tMonitor**, which monitors the results and prints a warning message if they are outside of the safety range.

The cobble program also includes the `progStart()` and `progStop()` routines. Later in the tutorial, you will use these routines to start and stop the program.

Before you add the sample program to the project, copy it from the Tornado installation tree to another location, such as the project directory you have set up with the Tornado project wizard.

The sample file cobble.c is located in `installDir\target\src\demo\start`.

In the examples provided thus far in the tutorial, c:\projects has been used as the base directory for our project work, and subsequent examples are based on cobble.c being copied to that directory.
After you have copied `cobble.c` to another location, add it to the project. Select Add Files from the context menu in the File view of the workspace:

Then use the file browser that appears to select `cobble.c`.

Open the Object Modules folder in the Files view so you can see the names of the object files that are built from the project:
The Tornado project facility automatically creates the file `projectName.out` as a single, partially linked module when a project is built. It comprises all of the individual object modules in a downloadable application project, and provides for downloading them all to the target simultaneously.

### 3.5 Build the Project

To review the default build settings defined when you created the project, select the Builds tab on the Workspace window, open the gizmo Builds folder, and double-click on the default build name (for example, SIMNT-gnu).

The properties sheet for the build appears, which you can use to review makefile rules and macros, as well as the compiler, assembler, and linker options used for the build.

When you display the C/C++ compiler page, you will note that the include debug info checkbox is selected by default. This selection ensures that optimization is turned off when the project is compiled with debug information:
Close the property sheet by clicking on the Cancel button.

Build the project by selecting Build 'gizmo.out' from the context menu:

The option Build 'projectName.out' builds all project modules as a single, partially linked module that is optimal for downloading to a target.

Before Tornado builds the project, the Dependencies dialog box warns you that makefile dependencies have not been calculated for cobble.c:

Click OK to continue.
Tornado calculates makefile dependencies and proceeds with building the project. If any external dependencies are found, they are automatically included in the project and listed in the External Dependencies folder in the Files view of the workspace.

The build output window displays any errors and warnings. In this case, there are none:

Close the Build Output window with the window control.

3.6 Download the Project to the VxWorks Target Simulator

You can download your project from the Files view of the workspace, and start the integrated simulator, all as part of the same process.

First display the Files view of the workspace window.
Then select the project folder name with the right mouse button and select the Download 'gizmo.out' option from the context menu:

Tornado prompts you to start a simulator:

Click Yes to continue.
The VxSim dialog box appears:

Leave Standard Simulator selected, and click OK to continue.

The target simulator window opens, and Tornado prompts you to start a target server. Click OK in the VxSim-Lite Launch dialog to continue:
A target server manages all communication between Tornado host tools, such as the debugger, and the target. The convention for target server names is `targetName@hostName`. In this example, the name of the target is `vxsim` (the default for the integrated simulator), and the name of the PC host is `ala-tau`.

The name of the target server is displayed in the Tornado launch toolbar:

![Tornado Toolbar](image)

The toolbar includes buttons for starting Tornado tools such as the browser, shell, and debugger. The buttons are activated when the target server is started.

**NOTE:** Both the browser button and the shell button both have the letter `i` in them, which may be confusing. The `i` in the shell button follows the `->` shell command prompt, where it is a shell command that displays target system information. The `i` in the browser button stands for *information* about the target.

### 3.7 Run the Application from the Tornado Shell

Before you run an application, it is often useful to configure and start the Tornado debugger, so that the debugger can respond automatically to any program exception.

The Tornado debugger (CrossWind) combines the best features of graphical and command-line debugging interfaces. The most common debugging activities, such as setting breakpoints and controlling program execution, are available through convenient point-and-click interfaces. Similarly, program listings and data-inspection windows provide an immediate visual context for the crucial portions of your application.
To configure the debugger, select Tools>Options>Debugger from the main Tornado window. When the Options dialog appears, select Always under Auto attach to tasks, so that the debugger will automatically attach to a task when an exception occurs:

Click OK to continue. For more information, see the Tornado User’s Guide: Debugger.

To start the debugger, use the debugger button in the Tornado launch toolbar. The back trace and variables windows open (you may close them), and the status line at the bottom of the main Tornado window announces that the debugger is running:

The Tornado shell (also known as WindSh) is a C-language command interpreter that allows you to invoke any routine from the shell command line that has been downloaded to the target. The shell also includes its own set of commands for managing tasks, accessing system information, debugging, and so on.
You can run the program from the shell command line. To start a shell, click the shell button.

When the shell window opens, run the program by entering the name of the main routine, `progStart`, at the command line:

```
$ progStart
```

### 3.8 Examine Target Memory Consumption

The Tornado browser is a system-object viewer that is a graphical companion to the Tornado shell. The browser provides display facilities to monitor the state of the target system, including summaries of active tasks, memory allocation, and so on.

To start the browser, click the browser button in the Tornado launch toolbar.
When the browser appears, Select Memory Usage from the drop down list and click the periodic refresh button. This will update the display every few seconds, and you will note that `cobble.c` has a voracious appetite for memory:

Stop the browser with the window control in the title bar.

### 3.9 Examine Task Activity

WindView is the Tornado logic analyzer for real-time applications. It is a dynamic visualization tool that provides information about context switches, and the events that lead to them, as well as information about instrumented objects such as semaphores, message queues, and watchdog timers.
Click the WindView button in the Tornado launch toolbar to display the WindView Control window. The WindView Collection Configuration dialog box also appears. Select Additional Instrumentation from the drop-down list and click OK:

![WindView Control window](image)

![Collection Configuration dialog box](image)

To begin data collection, click the GO button in the WindView Control window.

**NOTE:** Except where otherwise specified, the default configuration of WindView is used for this exercise. If WindView settings have been changed during another session, the behavior may vary from the description below.

Wait a few seconds, and then click the update button in the WindView Control window to update the status of data collection:

![WindView Control window](image)
When the **Buffers** value listed under **Current Content** reaches at least two, click the **Stop** button to end data collection.

You may notice a certain sluggishness in your machine’s performance, which is due to the sample program’s runtime misbehavior on the integrated simulator.

Before you upload the WindView data from the simulator target to the host, stop the sample program by entering `progStop` at the shell command line.

Then use the upload button to upload the data. A view graph is displayed while the data is uploaded.

When you maximize the view graph window, the data display should look something like the following:1

You can use the zoom buttons on the WindView toolbar to enlarge or decrease the size of the scope of the display, and scroll bar at the bottom of the view graph to display the rest of the data. (The zoom 100% button displays all of the

---

1. The color of the view graph display can be changed with **Tools**>**WindView**>**Options**.
data at once.) The flag-shaped icons indicate semaphore gives and takes. The horizontal lines indicate task states (executing, pending, ready, and so on). For information about the meaning of the WindView icons, select Help>WindView Help>Legend.

Note that tCrunch, the task that processes data and removes nodes from a linked list, never runs.

Close the view graph and click No in response to the dialog that prompts you to save the data with: Save changes to hostName?

Close the WindView Control window as well.

3.10 Fix Task Priorities and Find the Next Bug

Open the source code in the editor by double-clicking on cobble.c in the workspace Files view. Then find the progStart() routine, where you’ll discover that tCrunch is assigned a lower priority (240) than tMonitor (230), which never allows it to run. As a consequence, data is never processed, and nodes are never deleted from the linked list.

Edit the source file to reverse the priorities between the two tasks:

- Change the 240 argument in the taskSpawn() call for tCrunch to 230.
- Change the 230 argument in the taskSpawn() call for tMonitor to 240.

Then save the file.

Use the context menu in the Files view of the workspace, select the ReBuild All (gizmo.out) option to rebuild the project. When it is done, close the Build Output window.

Then download the project to the target with the Download ‘gizmo.out' option from the context menu.

NOTE: Do not forget to download the new gizmo.out to the target! And if you have stopped the debugger, restart it with the debugger button.

Start the program again from the Tornado shell with the command progStart.
Both the simulator and shell windows soon announce an exception and the number of the task in which it occurred:

In addition, the debugger opens the editor window automatically with a context pointer marking the position in the `crunch()` routine where the error was generated:

Before you proceed, reboot the target simulator: in the shell window, press RETURN to display the prompt, and enter `reboot`.

A message box announces that the target connection has been lost, and that the debugger is being stopped. Click OK.
If you use the `i` command in the shell window after you have rebooted the simulator, you see that only VxWorks system tasks are now running:

![i command output](image)

### 3.11 Fix the Last Bug and Take it for a Spin

Open the `cobble.c` file in your editor by double-clicking on the file name in the Files view of the workspace window. Fix the source of the exception error in the `crunch()` routine by using the commented code immediately below the division operation—or something more interesting. Save the file and close the Source view window.

Then use the context menu in the Files view of the workspace to select the ReBuild All (gizmo.out) option. When the build is done, close the Build Output window.

Download the application to the target with the Download 'gizmo.out' option from the context menu.

To be sure that everything is working, start the debugger with the debugger button.

Start the program again from the Tornado shell with the command `progStart`.

Click on the Windview button to display the WindView Control window. Then click the GO button in the WindView Control window to begin data collection.

Wait a few seconds, and click the update button in the WindView Control window to update the status of data collection.
When the **Buffers** value listed under **Current Content** reaches at least two, click the **Stop** button to end data collection.

Then use the upload button to upload the data. A view graph is displayed while the data is uploaded.

Maximize the view graph window and scroll through the WindView data. You should find that all tasks, including **tCrunch**, are running in an orderly manner, and the view graph data should look like the following:

![View graph data](image)

You can check memory consumption once again with the browser by clicking the browser button in the Tornado launch toolbar.

When the browser appears, select **Memory Usage** from the drop-down list and click the browser’s periodic refresh button. Every few seconds the display will be updated.
Notice that memory consumption fluctuates modestly within a constant range:

Moreover, output in the simulator window indicates that the program is humming along nicely, providing you with information about when it’s hot and when it’s not:

Stop the program by entering `progStop` at the shell command line.

Bye! Tschuess! Adieu!
3.12 What Next?

For detailed information about using features of the Tornado IDE such as the project facility, shell, browser, and debugger, see the *Tornado User’s Guide*. The guide also provides information about setting up your Tornado development environment with target hardware.

For information about VxWorks itself, see the *VxWorks Programmer’s Guide*, the *Network Programmer’s Guide*, and the *VxWorks API Reference*.

The Tornado documentation set is available online in HTML format from the main Tornado menu Help>Manuals Contents, or directly from the top level HTML file `installDir\tornado\docs\books.html`. 